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U.S. Department of HUD, Form HUD-5260

Instructions to Applicants: Public Housing Agencies

INTRODUCTION
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GENERAL INSTRUCTIONS

1 Complete one Application Form for each public housing project proposed for conversion.

2 Upon completion of the application, print out the associated attachments.

3

HOW THIS EXCEL WORKBOOK WORKS

OMB Approval Number 2577-xxxx
(Issue Date x/xx) (Expires x/xx)

Paperwork Reduction Notice: The information collection requirements contained in this notice have been approved by the Office 
of Management and Budget (OMB) under the Paperwork Reduction Act of 1995 (44 U.S.C. 3520).  Public reporting burden for this 
collection of information is estimated to average 2 hours per response, including the time for reviewing instructions, searching 
existing data sources , gathering and maintaining the data needed, and completing and reviewing the collection of information.  
This agency may not collect this information, and you are not required to complete this form, unless it displays a currently valid 
OMB control number. 

This collection of information is required for applying to the Rental Assistance Demonstration pursuant to PL-112-55 and HUD 
requirements as explained in PIH Notice PIH-2012-032.  The information will be used to provide HUD with sufficient information to 
enable a determination that the proposed conversion is financially feasible and that HUD statutory and regulatory requirements 
have been met.

Please address any comments or questions on this data collection to rad@hud.gov and the appropriate personnel will respond to 
your inquiry in a timely manner. HUD may not collect this information, and you are not required to complete this form unless it 
displays a currently valid OMB number. Limited confidentiality is assured.

Note: This Excel Spreadsheet has multiple worksheets listed in the tabs below.  Depending upon each worksheet’s applicability to 
your application, you may be required to fill out several of these worksheets in order for HUD to consider your application 
complete.  To navigate amoung the worksheets, click the indivdual worksheet tabs at the bottom of this window.  If no worksheet 
tabs are visible, select "Options ..." from the "Tools" menu.  In the dialogue box, select the "View" tab and then "Normal".

In accordance with Notice PIH-2012-32, this Excel-based Application Form shall be used by public housing 
agencies (PHAs) in submitting applications under the Rental Assistance Demonstration (RAD).

As part of the application, the user will be completing both an Operating Pro-Forma and a Development Budget 
for the proposed conversion. An application cannot be submitted (see "fatal error" message, below) if the Pro-
Forma or Development Budget do not balance or otherwise contain error messages.

Submit the completed application, along with the signed attachments (where applicable), and email to 
RADApplication@hud.gov.
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1

2 Fill in all items that appear in grey highlight.

3

4

5

In order to obtain this Excel workbook, go to the RAD website (www.hud.gov/rad), and click on 'Obtain Excel 
Application for PHAs'.  Enter the project's PIC Development Number.  The web site will auto-populate certain 
cells with information on the project from HUD systems.  You can then download this Excel workbook and save it 
on your computer.

Bright blue squares containing a white question mark offer additional guidance.               Place the mouse cursor 
over the square to read this guidance.

Note that, for the purposes of reviewing applications, HUD has standardized some of the financing assumptions. 
These benchmarks/assumptions are only for the purposes of reviewing the applications; actual lender 
underwriting may be different. If an entry trips one of these assumptions, an error message will appear, 
indicating either that the user provide an explanation or that the user enter an amount that complies with the 
standardized assumption.

If a "fatal error" message appears in red, the application cannot be submitted. Review the fatal error message 
and correct the input(s) as needed. The fatal error message will disappear once the input(s) has been corrected.

?
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6 Once all information has been entered, print the following form-generated attachments (where applicable):
          • Board Approval Form. This is a document that the PHA and the PHA Board must approve.  A PDF copy of 
the signed document must be submitted with the RAD Application.  It summarizes key aspects of the application. 
Failure to submit an executed form with the application will result in its rejection.
          • Financing Letter of Interest/Intent. This is a document that a lender or equity investor must sign.  A PDF 
copy of the signed document must be submitted with the RAD Application.  It is designed to give the lender or 
equity investor information on key aspects of the proposed transaction. A separate Financing Letter of 
Interest/Intent must be submitted for each proposed source of funding. Failure to submit all of the required 
Letters of Interest/Intent with the application will result in its rejection.
          • Mixed-Finance Affidavit. This is a document that the PHA and the owner-representative of the mixed-
finance project must sign.  A PDF copy of the signed document must be submitted with the RAD application for 
any mixed-finance project.  PHAs should note that the Notice provides that mixed-finance projects funded with 
HOPE VI grants are eligible only if the Date of Full Availability (DOFA) is October 1, 2002 or earlier; and
          • Choice-Mobility Letter Agreement. This is a document that will be signed by both the PHA that is 
providing choice-mobility vouchers and by the PHA (or Mod Rehab project owner) whose RAD project will 
receive the choice-mobility vouchers.  A PDF copy of the signed document must be submitted with the 
Application in order to qualify for the choice-mobility ranking factor.

These attachments will include the name of the authorized representative identified in the application. 
Additionally, the Board Approval Form and the Financing Letter of Interest/Intent will include both a Statement 
of Sources and Uses and a Financing Pro-Forma, generated from the information submitted on the Application 
Form.
Note that the Application Form, along with all the attachments, must be submitted electronically as part of the 
submission package. The full list of attachments needed will be automatically generated at the end of the 
Application Form once it has been completed.
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tabs are visible, select "Options ..." from the "Tools" menu.  In the dialogue box, select the "View" tab and then "Normal".

THE VALIDATION WORKSHEET

This worksheet shows the detailed calculations for potential PBRA and PBV rents.  It also shows the historical 
FASS-PH data for the referenced project. 
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Rental Assistance Demonstration (RAD) U.S. Department of HUD, Form HUD-5260

Public Housing Program Application Office of Public Housing, Office of Multifamily Housing

OMB Approval Number 2577-xxxx (Issue date x/xx) (Expires x/xx)

Section 1: PIC Development Number and Name
Enter the PIC Development Number and Name.

AL086000001 FULTON/BROOK/HICKORY/RED HOLLOW
Development Number Name of Development ?

Jefferson County Housing Authority 101705270
Public Housing Agency (PHA) Name Data Universal Numbering System (DUNS) #

Lewis McDonald 2058490123 lmcdonald@jcha.com
Executive Director Telephone Number Email

Section 2: Background Information on the PHA and the Project
Enter the requested contact information and complete the below questions regarding the project.

PHA Contact Name ? Title Telephone Number Email

Type of Conversion:  PBRA (Project Based Rental Assistance) ?

Is this Project an existing Mixed Finance Projec No ? The formulaic result from FASS data

Is this Project an existing Mixed Finance Projec No ? Corrected PHA entry  (if applicable)

Are you requesting the Choice-Mobility Exemption for this project?

Review the below table of project unit counts, by bedroom size, per the PIC data extract as of 06/01/12

PIC Bedroom Distribution

Total Units0-BR 1-BR 2-BR 3-BR 4-BR 5-BR 6-BR

0 20 104 65 16 0 0 205 2.38

Is the above PIC information correct? ?

Actual Bedroom Distribution (PIC corrected)

Total Units0-BR 1-BR 2-BR 3-BR 4-BR 5-BR 6-BR

0 20 104 65 16 0 0 205 2.38

Enter the date corrected or PIC ticket created (MM/DD/YYYY)

There are several explanation boxes that extend the full width of this form.  Increase or decrease the height of the box as needed 
(click to the left on the horizontal line below the row number, then drag the line up or down as needed).

Average 
Bedroom 
per Unit

Average 
Bedroom 
per Unit
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Total Units0-BR 1-BR 2-BR 3-BR 4-BR 5-BR 6-BR

Units Converting 0 20 104 54 16 0 0 194 

Market Rate 0 

Other Affordable 0 

Total 0 20 104 54 16 0 0 194 

?
0-BR 1-BR 2-BR 3-BR 4-BR 5-BR 6-BR Monthly

Utility Allowances

Reasonable Rents

Fatal Error: Reasonable Rents are not entered for all Unit Types

Section 3: De Minimis Reduction

de minimis threshold

205 194 11 10 1

     Units have already received Section 18 Demolition-Disposition approval from HUD
     Reconfiguring efficiency apartments
     Facilitating social service delivery
     Units vacant for more than 24 months
     Partial conversion ? Fatal Error: No explanation of unit(s) over de minimis is provided.

0      Total Fatal Error: The total must equal the number of units above de minimis.

Proposed Post-RAD-Conversion Unit Distribution. Below, show the mix of units that you have proposed to 
convert, as well as other dwelling units at the project

For units converting under RAD, enter the current utility allowances and estimated reasonable rent 
determinations for each unit type. 

The table below compares the current total public housing units, the number proposed for conversion, the 
number proposed to be reduced, and the applicable de minimis threshold.  Indicate the number of reductions by 
category in the rows that follow, along with an explanation in the accompanying text box.

Current Public 
Housing Units

Total Units 
Proposed for 
Conversion

Units Proposed to be 
Reduced

Units above the de 
minimis threshold

A beyond de minimis reduction in number of assisted units is proposed.  Indicate how many above de minimis units apply to each 
reduction reason below.  Do not count the units more than once. An explanation for each of these units is required.

Please provide an explanation of each unit above de minimis in re each affected category. 
Please limit response to 200 words.
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Section 4: Existing Indebtedness, Capital Needs, and Replacement Reserves
Enter below information on the project's existing indebtedness, if applicable: ?

Energy Performance Contract (EPC) Per Unit $0 
Capital Fund Financing Program (CFFP) Per Unit $0 
Other Per Unit $0 
Other Per Unit $0 
Other Per Unit $0 
Total $0 Per Unit $0 

Capital Needs: ?
What are your capital needs?
   Year 1 (Immediate) ? $0 Per Unit $0 

Years 2-5 (Short-term) $0 Per Unit $0 
Years 6-20 (Long-term) $0 Per Unit $0 

Please explain how you have arrived at these estimates.
Explanation

Replacement Reserve Funding ?
Enter the Initial Deposit and Annual Deposit to replacement reserves below.
  Formula Amount Your Proposal

   Initial Deposit to Repl. Reserve (IDRR) $0 $0 

   Annual Deposit to Repl. Reserve (ADRR) $0 $0 ?

Section 5: Vacancy Loss and Bad Debt Loss, for Assisted Units
Enter vacancy and bad debt data for the proposed conversion.

3 Yr Historical Avg Proposed

Vacancy Rate (%) ? 2.06% 3.00%
Skip; no explanation necessary

Bad Debt Rate (%) ? 1.80% 2.00%
Skip; no explanation necessary

Enter the most recent estimate of capital needs for the project, broken down by Immediate, Short-term, and 
Long-term needs. If these break-downs are not available, provide reasonable estimates. 
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Section 6: Other Rent Potential, Vacancy Loss and Bad Debt Loss

Type of Add'l Gross Potential Rent Annual GPR Vacancy Loss % Bad Debt Loss %

Market rate apartments
Other affordable apartments
Office space
Retail space

Section 7: Other Income
Enter other income for the planned project. ?

Annual

Late / NSF charges Explanation

Damage charges Explanation

Laundry / Vending Explanation

Other Explanation

Other Explanation

Other Explanation

In addition to units that will be included under the HAP contract, enter other rent potential, vacancy loss, and 
bad debt loss for the proposed conversion.
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Section 8: Operating Expenses

Are you proposing the conversion in conjunction with new construction? Yes

Proposed

Administrative $0  
Explanation

Asset Management Fee $0  
Explanation

Tenant Services $0  
Explanation

Utility Expense $0  
Explanation

Ordinary Maint and Ops $0  
Explanation

Protective Services $0  
Explanation

Real Estate Taxes $0  
Explanation

Property Insurance $0  
Explanation

Liability Insurance $0  
Explanation

Other General Expenses $0  
Explanation

Total Operating Expenses $0 $0 

3 Year Historical Expenses: ? New Construction: Historical Operating Expenses are N/A

2009 AFS 2010 AFS 2011 AFS Missing

$0 $0 $0 

PHA Corrected 3 Year Historical Expenses: New Construction: Corrected Operating Expenses N/A
2009 AFS 2010 AFS 2011 AFS 3 Year Average

$0 $0 $0 $0 

New Construction : Section Not Applicable. No explanation is required.
Explanation

Enter only the proposed conversion Operating Expenses.  Leave the first column as zero. No explanations are required at this 
time.

Latest Approved 
Operating Budget

New Construction; Proposed entries 
are required for all applicable line 

items
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Section 9: Net Operating Income

Apartment Gross Potential Rent:
RAD Units $1,308,936 194 Units $6,747 per unit annual
Market Rate Units $0 0 Units $0 per unit annual
Other Affordable Units $0 0 Units $0 per unit annual

Office / Retail GPR $0 RAD

Vacancy and Bad Debt Loss ($65,447) 5.0% weighted average
Other Income $0 

Effective Gross Income $1,243,489 

Total Operating Expenses $0 $0 PUPA
Annual Reserve Deposit $0 $0 PUPA

Net Operating Income $1,243,489 

Section 10: First Mortgage Loan Sizing

Yes

Enter the below information regarding the anticipated first mortgage loan.

Do you anticipate using FHA Insurance?

Interest Rate % per Year ?
Mortgage Insurance Premium % ?
Amortization Term ?
Maturity Term ? Less than reasonable amount of years

Debt Service Coverage Ratio ? Fatal Error: Must be at least 1.20

   Maximum Supportable Mortgage Loan $0 
Proposed Mortgage Loan Amount ?
  Calculated Annual Debt Service $0 

Section 11: Total Uses of Funds (Total Development Cost)
Enter uses of funds for the proposed conversion.

Acquisition Costs
Building and Land Acquisition ?
Payoff Existing Loans $0 
Other Costs ?

Construction Costs ? $0 

Relocation Costs ?

Presented below is a summary calculation of the proposed project's Net Operating Income. Before proceeding, 
review and make any necessary changes in the applicable section of the application.

Are you proposing to take out a first mortgage 
loan for this project?

Fatal Error: Interest + MIP must be at least 
3.50%
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Professional Fees
Architecture & Engineering ?
Physical Conditions Assessment ?
Borrower's Legal Counsel ?
Lender's Legal Counsel ?
Feasibility Studies ?
Environmental Reports ?
Appraisal / Market Study ?
Accounting ?
Survey ?

  Other Costs ?
Loan Fees and Costs

FHA MIP ?
FHA Application Fee ?
FHA Inspection Fee ?
Financing Fee ?
Organizational Costs ?
Title Insurance/Exam Fee ?
Recordation Fee ?
Closing Escrow Agent Fee ?
Prepayment Penalty/Premium ?
Payables ?
Construction Interest ?
Construction Loan Fees ?
Cost of Bond Issuance ?

  Other Costs ?
Reserves

Initial Deposit to Replacement Reserve ? $0 
Initial Operating Deficit Escrow ?
Operating Reserve ?
Tax and Insurance Escrow ?

  Other Costs ?

Developer Fees ?
   Total Development Cost $0 aka Total Uses of Funds

Section 12: Total Sources of Funds
Enter sources of funds for the proposed conversion. 

New First Mortgage Loan $0 
Public Housing Operating Reserves
Public Housing Capital Funds
Replacement Housing Factor
Low Income Housing Tax Credit Equity - 4%
Low Income Housing Tax Credit Equity - 9%
Other/Local
Other/Local
Other/Local

   Total Sources of Funds ? $0 
Sources and uses are in balance
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LIHTCs are not proposed; skip to Section 14

Section 13: Projects Utilizing  Low Income Housing Tax Credits ('LIHTCs')
You are not proposing to use LIHTCs. Skip this section. ?
Do you have a LIHTC reservation?

Discussion of QAP timing

Demonstration of recent success obtaining 9% LIHTCs

Provide evidence that the applicant diligently attempted to secure such a letter
Efforts to secure letter from credit-issuing authority

Likelihood of obtaining 9% LIHTCs

Section 14: Ranking Factors
1) Do you want to designate this project as your PHA’s priority project? ?

2) Are you applying for a ranking factor for Choice Mobility

(a) Are you receiving choice-mobility vouchers
(b) Are you providing choice-mobility vouchers

3) Are you requesting the Ranking Factor for Green Building and Energy Efficiency?
Describe the certification you will pursue, if applicable

Briefly discuss the application submission and approval timing that is provided under the current QAP. Please provide sufficient 
detail that HUD can understand when you will submit an application, when you will be notified regarding selection, and when a 
LIHTC Reservation letter would be issued to you.

RAD requires that you demonstrate recent success, internally or through development team partners, in obtaining 9% LIHTCs. 
Below, briefly discuss your capacity and experience in obtaining 9% LIHTCs from the relevant State allocating agency.

Do you have a letter from the credit-issuing authority as described in Section 1.9(B) of the RAD 
Notice?

RAD requires that you attach a self-scored QAP application. Below, briefly discuss why you believe that a QAP application for the 
subject project, at the indicated score, is likely to receive a 9% LIHTC award.
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Section 15: Additional Narratives
 Provide written responses in the grey highlighted rows below. Please limit each responses to 200 words.

Briefly describe the land, location / neighborhood, and physical plant for the project. 
Description

Explanation

Discuss any needed accessibility modifications. ?
Explanation

Explanation

Discuss any proposed relocation plans for the project. 
Explanation

Discuss the capacity of the development team to undertake the proposed conversion. ?
Explanation

Discuss any known environmental or building product risks such as lead based paint, asbestos, PCBs, flood zone status, aluminum 
wiring, and fuel storage tanks (whether underground or above ground), along with associated remediation measures.

Discuss any known market competitiveness issues, such as small unit sizes or limited on-site parking, and how the conversion plans 
to address these issues.
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Section 16: Required Attachments
The Following Must Be Attached as Part of Your Electronic Application:

Yes Board Approval Form
No Evidence of PHA to Administer PBV Contracts
No Mixed-finance Affidavit
Yes Financing Letter of Interest/Intent for New First Mortgage Loan
No Financing Letter of Interest/Intent for 4% LIHTCs
No Financing Letter of Interest/Intent for 9% LIHTCs
No Choice-Mobility Letter Agreement
No 9% LIHTC Reservation Letter
No Letter from credit-issuing authority
No Self-Scored QAP Application for 9% LIHTCs
No QAP Timeline
Yes Resident Comments

No changes were made to the PIC data

This application will be rejected if submitted; there are 5 fatal errors.

The 3 attachments indicated 'Yes' above must be included in your electronic application package.  Incomplete application packages 
will be rejected, and if you re-submit, your place on the waiting list will be based on the date of re-submission.



Attachment 1A: Board Approval Form
This application will be rejected if submitted; there are 5 fatal errors.

Jefferson County Housing Authority RAD Application for FULTON/BROOK/HICKORY/RED HOLLOW

AMP No: AL086000001

Units 205

Type of Conversion

PBRA (Project Based Rental Assistance)

Proposed Units for Conversion and De Minimis

Summary

194 11 10
Explanation for de minimis reduction Unit Count

Pro Forma Sources and Uses

Sources of Funds Amount Per Unit

New First Mortgage Loan $0 $0

Public Housing Operating Reserves $0 $0

Public Housing Capital Funds $0 $0

Replacement Housing Factor $0 $0

Low Income Housing Tax Credit Equity - 4% $0 $0

Other $0 $0

Other $0 $0

Other $0 $0

Total Sources of Funds $0 $0

Uses of Funds Amount Per Unit

Acquisition Costs $0 $0

Construction Costs $0 $0

Relocation Costs $0 $0

Professional Fees $0 $0

Loan Fees and Costs $0 $0

Reserves $0 $0

Developer Fees $0 $0

Total Uses of Funds $0 $0

Stabilized Cash Flow Pro Forma

Total PUPA

Gross Potential Rents for RAD Units $1,308,936 $6,747

Gross Potential Rents for Other Apartment Units $0 $0

Gross Potential Rents for Commercial $0 N/A

Vacancy Loss and Bad Debt Loss ($65,447) -$337

Other Income $0 $0

Effective Gross Income $1,243,489 $6,410 

Total Operating Expenses $0 $0 

Annual Deposit to Replacement Reserve $0 $0 

Net Operating Income $1,243,489 $0 

First Mortgage Debt Service $0 $0 

Operating Cash Flow $1,243,489 $0 

PHA's Explanation of Any Relocation of Tenants (Estimated Relocation Cost is $0)
N/A

PHA's Explanation of Capacity and Experience to Carry Out the RAD Conversion
N/A

Total Units 
Proposed for 
Conversion

Units Proposed to 
be Reduced

de minimis 
threshold
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This application will be rejected if submitted; there are 5 fatal errors.

Jefferson County Housing Authority RAD Application for FULTON/BROOK/HICKORY/RED HOLLOW

PHA's Explanation of the Proposed Total Operating Cost being less then 85% of the 3 Year Historical Operating Expenses

3 Year Historical Average Comparison

2009 2010 2011 Average Proposed

$1,216,159 $1,152,883 #N/A $1,184,521 $0

N/A

PHA's Explanation of the Capital Needs and Replacement Reserves Estimates
N/A

Discussion of QAP timing
N/A

Demonstration of recent success obtaining 9% LIHTCs
N/A

Likelihood of obtaining 9% LIHTCs
N/A

Warning: HUD will prosecute false claims and statements. Conviction may result in criminal and/or civil penalties (18 USC Sections 1001, 1010, 1012; 31 USC Sections 3729, 3802)

 PHA Certification: By Lewis McDonald (Executive Director)

December 30, 1899

Signature: Date:

I hereby certify to the following: (1) that I have the requisite authority to execute this  application on behalf of the owner; (2) that HUD can rely upon this certification in evaluating the 
Application, (3) that I acknowledge that I have read and understand PIH Notice 2012-32 (the "Notice"), which describes the Rental Assistance Demonstration (RAD) (the "Program"), and 
agree to comply with all requirements of the Program or Notice; (4) that all materials submitted in association with the application are accurate, complete and not misleading; (5) that the 
application meets all applicable eligibility requirements for the Program set forth in the Notice; (6) that the owner approves the creation of a single-asset entity of the affected project if 
required by the lender to facilitate financing; (7) that, if selected for award, the owner will comply with the fair housing and civil rights requirements at 24 CFR 5.105(a) (general 
requirements) and will affirmatively further fair housing; (8) that there are no debarments, suspensions, or Limited Denials of Participation in Federal programs lodged against the applicant, 
PHA Executive Director, Board members, or affiliates; (9) that this Board Approval Form has been approved by the Board of Commissioners on the date noted below; and (10) that, if 
selected for an award, the PHA will comply with all provisions of HUD’s Commitment to Enter into a HAP (CHAP), which shall indicate the HUD-approved terms and conditions for conversion 
of assistance, or will indicate to HUD within 15 days that it is refusing the terms of the CHAP and withdrawing from RAD participation. 



Attachment 1B: Financing Letter of Interest/Intent

Jefferson County Housing Authority RAD Application for FULTON/BROOK/HICKORY/RED HOLLOW

AMP No: AL086000001

Units 205

Type of Conversion

PBRA (Project Based Rental Assistance)

Pro Forma Sources and Uses

Sources of Funds Amount Per Unit

New First Mortgage Loan $0 $0

Public Housing Operating Reserves $0 $0

Public Housing Capital Funds $0 $0

Replacement Housing Factor $0 $0

Low Income Housing Tax Credit Equity - 4% $0 $0

Other $0 $0

Other $0 $0

Other $0 $0

Total Sources of Funds $0 $0

Uses of Funds Amount Per Unit

Acquisition Costs $0 $0

Construction Costs $0 $0

Relocation Costs $0 $0

Professional Fees $0 $0

Loan Fees and Costs $0 $0

Reserves $0 $0

Developer Fees $0 $0

Total Uses of Funds $0 $0

Stabilized Cash Flow Pro Forma

Total PUPA

Gross Potential Rents for RAD Units $1,308,936 $6,747

Gross Potential Rents for Other Apartment Units $0 $0

Gross Potential Rents for Commercial $0 N/A

Vacancy Loss and Bad Debt Loss ($65,447) -$337

Other Income $0 $0

Effective Gross Income $1,243,489 $6,410 

Total Operating Expenses $0 $0 

Annual Deposit to Replacement Reserve $0 $0 

Net Operating Income $1,243,489 $0 

First Mortgage Debt Service $0 $0 

Operating Cash Flow $1,243,489 $0 

PHA's Explanation of the Proposed Total Operating Cost being less then 85% of the 3 Year Historical Operating Expenses

3 Year Historical Average Comparison

2009 2010 2011 Average Proposed

$1,216,159 $1,152,883 #N/A $1,184,521 $0

N/A



Attachment 1B: Financing Letter of Interest/Intent

PHA's Explanation of the Capital Needs and Replacement Reserves Estimates
N/A

Discussion of QAP timing
N/A

Demonstration of recent success obtaining 9% LIHTCs
N/A

Likelihood of obtaining 9% LIHTCs
N/A

Statement of Lender / Equity Provider:

State any exceptions or additional conditions

ABC Mortgage Corporation: By Gustavo Martinez (Vice President)

December 30, 1899

Signature: Date:

The project appears feasible for ABC Mortgage Corporation to fund.  Our general repayment terms and any conditions are stated above and/or in the comment block below.  ABC Mortgage 
Corporation understands and acknowledges the RAD program requirements and policies and agrees to cooperate with the applicable RAD processes, as appropriate. This letter of 
interest/intent is not a firm commitment.  Final approval will be contingent on the results of ABC Mortgage Corporation due diligence process and approvals.



Attachment 1C –Mixed-Finance Affidavit

Of Jefferson County Housing Authority

And 
Regarding Jefferson County Housing Authority RAD Application for FULTON/BROOK/HICKORY/RED HOLLOW

1.

2.

3.

(b) Agree to Section 8 contract rent levels in accordance with RAD and the Notice.

(c) Comply with all applicable requirements of RAD and the Notice.

Jefferson County Housing Authority: By Lewis McDonald (Executive Director)

December 30, 1899

Signature: Date:

: By  ()

December 30, 1899

Signature: Date:

Lewis McDonald certifies that he or she is the Executive Director of Jefferson County Housing Authority and 
that he or she has been authorized by Jefferson County Housing Authority to execute this Mixed Finance 
Affidavit.

 certifies that he or she is the  of  and that he or she has been authorized by  to execute this Mixed Finance 
Affidavit.

Jefferson County Housing Authority and , through their duly authorized representatives, agree that if the 
application for FULTON/BROOK/HICKORY/RED HOLLOW (AL086000001), is awarded entry into the Rental 
Assistance Demonstration, they will, if requested to do so by HUD:

(a) Convert the subject project’s current subsidy to long-term Section 8 rental assistance in 
accordance with the requirements of the Rental Assistance Demonstration ("RAD") including, 
without limitation, the requirements of Notice PIH-2012-32 (the "Notice").

(d) Enter into one or more agreements to carry out the foregoing commitments.  Such 
agreements shall include, without limitation, a Housing Assistance Payments (HAP) contract that:

(a) In the case of a RAD conversion to project based rental assistance, shall be 
between the project owner and the contract administrator designated by HUD; and 

(b) In the case of a RAD conversion to project based voucher assistance, shall be 
between the project owner and a public housing authority designated by HUD.



Attachment 1D – Choice-Mobility Letter Agreement
Between  (contributing vouchers)

And  (receiving vouchers)
Regarding Jefferson County Housing Authority RAD Application for FULTON/BROOK/HICKORY/RED HOLLOW

1.

2.

3.

4.

5.

6.

: By  ()

December 30, 1899

Signature: Date:

: By  ()

December 30, 1899

Signature: Date:

Capitalized terms herein shall have the meaning given to them in Notice PIH-2012-32 (the "Notice") and 
in the Rental Assistance Demonstration ("RAD").

 certifies that he or she is the  of  and that he or she has been authorized by  to enter into this Choice-
Mobility Letter Agreement regarding the RAD application submitted by FULTON/BROOK/HICKORY/RED 
HOLLOW (AL086000001).

 certifies that he or she is the  of  and that he or she has been authorized by  to enter into this Choice-
Mobility Letter Agreement regarding the RAD application submitted by FULTON/BROOK/HICKORY/RED 
HOLLOW (AL086000001).

, through its duly authorized representative, commits that if the subject project converts assistance 
under RAD,  will provide Section 8 Housing Choice Vouchers to the assisted residents of the subject 
project to achieve the choice-mobility objective described in Section 1.7(5)(C) of the Notice.   agrees 
that this commitment is binding on  without regard to whether any RAD application submitted by  is 
selected for participation in RAD.

 acknowledges that if the subject project's application for RAD conversion is incomplete, fails to meet 
threshold criteria, or is submitted outside of the Initial Application Period,  will not earn any Ranking 
Factor.  However, if such application is submitted during the Initial Application Period, is complete, and 
meets threshold criteria, then  will earn a Ranking Factor regardless of whether such application is 
selected, or, once selected, is withdrawn or terminated.

 acknowledges that if the subject project's application for RAD conversion is incomplete, fails to meet 
threshold criteria, or is submitted outside of the Initial Application Period,  will not earn any Ranking 
Factor. 



Formula RAD Rents (PBRA and PBV)

Funding Baseline (pre-RAD) Annual Per Unit PUPM 205 ACC units in PIC (after any corrections)

Operating Fund $977,137 $4,767 $397.21
Capital Fund $257,496 $1,256 $104.67
Tenant Payments $160,121 $781 $65.09

   Total $1,394,754 $6,804 $566.97

Funding Utilized if PBRA Selected $1,308,936 $6,747 $562.26 93.8% of baseline funding is utilized
Funding Utilized if PBV Selected $0 $0 $0.00 0.0% of baseline funding is utilized

Baseline Funding By Unit Type 0-BR 1-BR 2-BR 3-BR 4-BR 5-BR 6-BR Monthly Annual

Units 0 20 104 65 16 0 0 205 205

FMR $605 $673 $750 $952 $980 $1,127 $1,274

Ratio FMR : 2BR FMR 0.807 0.897 1.000 1.269 1.307 1.503 1.699

# Units of 2BR FMR Equivalents 0.00 17.95 104.00 82.51 20.91 0.00 0.00 225.36
BR Adjusted Rents $416 $463 $516 $655 $674 $775 $877
Proposed Units 0 20 104 54 16 0 0
Preliminary Actual Rents $0 $463 $516 $655 $674 $0 $0 $109,078 $1,308,936

Formula Rents if Project Based Rental Assistance is Proposed:

0-BR 1-BR 2-BR 3-BR 4-BR 5-BR 6-BR Monthly Annual

Units 0 20 104 54 16 0 0 194 194

Preliminary Contract Rents $0 $463 $516 $655 $674 $0 $0 $109,078 $1,308,936

FMR $605 $673 $750 $952 $980 $1,127 $1,274 $158,548 $1,902,576

Utility Allowance $0 $0 $0 $0 $0 $0 $0 $0 $0

Rent Reasonable $0 $0 $0 $0 $0 $0 $0 $0 $0

120% FMR, minus Utility Allowance $726 $808 $900 $1,142 $1,176 $1,352 $1,529 $190,244 $2,282,928

150% FMR, minus Utility Allowance $908 $1,010 $1,125 $1,428 $1,470 $1,691 $1,911 $237,822 $2,853,864

PBRA-Contract Rent * $463 $516 $655 $674 $109,078 $1,308,936

* Lower of preliminary contract rent and [120% of FMR minus utility allowance].  Reasonable rent does not affect this calculation.

Formula Rents if Project Based Vouchers are Proposed:

0-BR 1-BR 2-BR 3-BR 4-BR 5-BR 6-BR Monthly Annual

Units 0 20 104 54 16 0 0 194 194

Preliminary Contract Rents $0 $463 $516 $655 $674 $0 $0 $109,078 $1,308,936

Rent Reasonable $0 $0 $0 $0 $0 $0 $0 $0 $0

FMR $605 $673 $750 $952 $980 $1,127 $1,274 $158,548 $1,902,576

Utility Allowance $0 $0 $0 $0 $0 $0 $0 $0 $0

110% FMR, minues Utility Allowance $666 $740 $825 $1,047 $1,078 $1,240 $1,401 $174,403 $2,092,834

PBV-Contract Rents ** $0 $0 $0 $0 $0 $0

** Lowest of preliminary contract rent, reasonable rent, and [110% of FMR minus utility allowance]



Latest Board Approved Operating Expenses

2009 AFS 2010 AFS #N/A 3 yr Average

Provided? Yes Yes MISSING

Vacancy Loss % 1.62% 2.51% #N/A 2.06% 1 year of data missing; average is 2 years

Total Operating Expenses: $1,186,674 $1,135,141 #N/A

Administrative $458,532 $436,237 #N/A $447,385 1 year of data missing; average is 2 years

Asset Management Fee $24,720 $24,720 #N/A $24,720 1 year of data missing; average is 2 years

Tenant Services $22,755 $16,082 #N/A $19,419 1 year of data missing; average is 2 years

Utility Expense $203,977 $215,545 #N/A $209,761 1 year of data missing; average is 2 years

Ordinary Maint and Ops $447,104 $412,542 #N/A $429,823 1 year of data missing; average is 2 years

Protective Services $0 $0 #N/A $0 1 year of data missing; average is 2 years

Real Estate Taxes $0 $0 #N/A $0 1 year of data missing; average is 2 years

Property Insurance $27,947 $28,376 #N/A $28,162 1 year of data missing; average is 2 years

Liability Insurance $1,639 $1,639 #N/A $1,639 1 year of data missing; average is 2 years

Other General Expenses $0 $0 #N/A $0 1 year of data missing; average is 2 years

Bad Debt Loss ($) $29,485 $17,742 #N/A $23,614 1 year of data missing; average is 2 years

2 Years Prior 1 Year Prior Most Recent 3 yr Average

Total FASS Operating Expenses: $1,216,159 $1,152,883 #N/A $1,184,521 1 year of data missing; average is 2 years

3 yr Average Corrected

Vacancy Loss % 2.06% 2.06%

Total Operating Expenses: $1,160,908 $1,160,908
Administrative $447,385 $447,385
Asset Management Fee $24,720 $24,720
Tenant Services $19,419 $19,419
Utility Expense $209,761 $209,761
Ordinary Maint and Ops $429,823 $429,823
Protective Services $0 $0
Real Estate Taxes $0 $0
Property Insurance $28,162 $28,162
Liability Insurance $1,639 $1,639
Other General Expenses $0 $0

Bad Debt Loss ($) $23,614 $23,614
Other General exp (net of bad debt) -$23,614 -$23,614

2010 Capital Needs Study Definition for 'Elderly' and 'Family' Projects

Number of 2+ Bedroom Units 185 PIC data (before any corrections)
Average # Bedrooms 2.38 PIC data (before any corrections)

Family Definition 1 Yes At least 1.5 bedrooms per unit
Family Definition 2 No
Elderly No All others

Occupancy Type for Preference Family Use this designation for purposes of the preference for high-rehab projects

Between 1.2 and 1.5 and at least 100 2+ bedroom units



PIC Data Element PIC Value Corrected Value

AMP No AL086000001 AL086000001

0-BR 0 0

1-BR 20 20

2-BR 104 104

3-BR 65 65

4-BR 16 16

5-BR 0 0

6-BR 0 0

Units 205 205

Average Bedroom Size 2.38 2.38

FMR (bedroom adjusted) $824 $824

Utility Allowance (brm adj) $117 $117

Operating Fund per unit $4,767 $4,767

Operating Fund PUM $397 $397

Capital fund per unit $1,256 $1,256

Capital Fund PUM $105 $105

Tenant Payments Per unit $781 $781

Tenant payments PUM $65 $65

Current Funding to FMR % 69% 69%

Primary PHA Signatory Lewis McDonald Lewis McDonald

Position Executive Director Executive Director

Phone 2058490123 2058490123

Email lmcdonald@jcha.com lmcdonald@jcha.com

Mixed Finance No No

Housing Authority Jefferson County Housing Authority Jefferson County Housing Authority

DUNS number 101705270 101705270

   Total Corrections



AMP_ID

AK001011   0 0 0 0 0 0 0 0 0 0

MANAGEMENT 
FEE 
ITEM_91300

OTHER 
ITEM_91900

ADMIN.ITEM_9
1000

ASSET 
MANAGEMENT 
FEE 
ITEM_92000

TENANT 
SERVICES 
ITEM_92500

TOTAL Utility 
ITEM_93000

TOTAL MAINT. 
ITEM_94000

TOTAL 
PROTECTIVE 
ITEM_95000

PROPERTY 
INSURANCE 
ITEM_96110

LIABILITY 
INSURANCE 
ITEM_96120



31-Dec-09

FYE_DT (copy for 
lookups)
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